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ABSTRACT 

Desertification, a pressing environmental and socioeconomic challenge, is 

significantly impacting arid and semi-arid regions around the world, including 

Gamawa Local Government Area (LGA) within Bauchi State, Nigeria. This study 

employs Remote Sensing (RS) and Geographic Information Systems (GIS) techniques 

to assess the extent of desertification in Gamawa LGA. Specifically, the study 

analyzes land-use and land-cover changes that occurred between 1999 and 2022 

using Landsat satellite imagery and the Maximum Likelihood classification 

algorithm. Additionally, it explores the topographical characteristics of the region 

using SRTM Digital Elevation Model (DEM) data and GIS tools. The results reveal 

significant shifts in land-use categories. Notably, built-up areas have expanded by 

999.98%, while cropland has decreased by 5.10%, vegetation cover by 44.35%, and 

water bodies by a substantial 85.41%. These findings strongly suggest that Gamawa 

LGA has undergone considerable land degradation and desertification over the past 

years. This study offers valuable insights for environmental scientists and 

governmental planning agencies. The information obtained can support the 

development of sustainable practices and effective governance strategies to combat 

land degradation, and desertification, and ensure the conservation of land resources 

in Gamawa LGA. 
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1. INTRODUCTION 

Desertification, the process by which once-productive land beyond natural desert 

boundaries deteriorates and loses its ability to support vegetation and sustain 

productivity Al-Kulabi, (2022), is a pressing environmental and socio-economic 

challenge impacting dry and semi-arid regions worldwide, including Gamawa LGA 

in Bauchi State, Nigeria. While the term is often visualized through stark images of 

encroaching dunes or cracked soil, desertification encompasses a broader range of 
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detrimental changes, including erosion, biodiversity loss, declining soil fertility, and reduced carbon storage capacity (Prince and 

Podwojewski, 2019). Several factors contribute to desertification, primarily unsustainable human activities like uncontrolled 

deforestation, overgrazing, and improper land management practices (Tudor et al., 2021).  

Climate change, characterized by droughts, extreme temperatures, and erratic rainfall patterns, further exacerbates the problem (Al-

Kulabi, 2022). In Gamawa LGA, for instance, deforestation for fuelwood and bush burning are common practices contributing to 

desertification Amankwah, (2020), alongside recent changes in weather patterns negatively impacting crop yields. The global response 

to desertification has seen both progress and challenges. The United Nations played a key role in raising awareness, with resolutions 

passed in 1974 leading to an international conference on desertification in 1977 (Al-Kulabi, 2022). However, a lack of consensus on the 

extent and severity of desertification, along with potentially misleading projections from international organizations Prince and 

Podwojewski, (2019), has hindered effective solutions.  

Moreover, the term itself has been misused, often reduced to simplistic imagery that doesn't capture the full spectrum of 

desertification's impacts (You et al., 2021). Research plays a crucial role in understanding and combating desertification. Studies like 

one conducted in Ghana highlight the role of deforestation and unsustainable practices in desertification Amankwah, (2020), 

emphasizing the need for afforestation and improved land management strategies. Remote sensing and Geographic Information 

Systems (GIS) have emerged as valuable tools for assessing desertification patterns and land degradation more precisely (Liang et al., 

2021). These technologies offer a comprehensive approach through data integration, spatial analysis, and ground information (Yin, 

2022).  

However, limitations exist, including the need for higher-resolution data and improved methodologies for detecting low-intensity 

degradation (Higginbottom and Symeonakis, 2014; Nour-Eldin et al., 2020). Overall, desertification research is critical for developing 

effective prevention and control measures. By utilizing advanced technologies like remote sensing and GIS, researchers can gain a 

deeper understanding of desertification's causes, impacts, and spatial distribution (Abd and El-Sayed, 2022; Wuyep et al., 2021). This 

knowledge is essential for informing policy decisions, land management strategies, and ultimately, promoting sustainable development 

in vulnerable regions (Gabriele et al., 2022; Liang et al., 2021). 

 

2. THE STUDY AREA 

Gamawa Local Government Area (LGA) is a predominantly rural area situated in the northeastern part of Bauchi State, Nigeria. The 

town of Gamawa serves as the LGA's headquarters. Gamawa LGA borders several neighboring LGAs: Zaki to the northeast, 

Itas/Gadau to the southeast, Katagum and Dambam to the south, Nangere to the northwest, and Jakusko to the northeast. The area 

encompasses roughly 2,857.46 square kilometers and stretches latitudinally between 11.645°N and 12.388°N, and longitudinally 

between 9.908°E and 11.28°E (Figure 1). 

 

Types and sources of data  

This describes the specific type of data that is going to be used, which in this case, are Landsat images (Table 1). Explain the 

characteristics of Landsat data, such as spatial resolution and temporal coverage 

 

Table 1 Showing the categories of types and sources of data 

S/No Type of Data Spatial Resolution Date Path and row Source Purpose 

1 Landsat 7 ETM+ 30 meters 1999 187 and 52 USGS LULC 

2 Landsat 7 ETM+ 30 meters 2012 187 and 52 USGS LULC 

3 Landsat 8 OLI/TIRS 30 meters 2022 187 and 52 USGS LULC 

4 SRTM DEM 30 meters 2014 
Coordinates: 11,10 

Coordinates: 12,10 
USGS 

Elevation, slope, 

aspect, and landforms 
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.  

Figure 1 Study Area map of Gamawa L.G.A  

Source: Adapted and modified administrative map of Nigeria 

 

Atmospheric correction 

To perform atmospheric correction on a loaded Landsat image in QGIS, follow these steps: access the SCP tool by navigating to 

Plugins, Semi-Automatic Classification, Tools, Atmospheric Correction (Surface Reflectance). This action opens the Atmospheric 

Correction window, where you can specify the input parameters, including the date and time of image acquisition, image location, 

atmospheric conditions, and sensor characteristics. Most of these parameters can be obtained from the metadata file accompanying the 

Landsat image. Once the input parameters are set, initiate the atmospheric correction process by clicking the "Run" button. The SCP 

tool applies an atmospheric correction algorithm to eliminate atmospheric interference from the Landsat image and produces a new 

image with surface reflectance values. 

 

Image classification 

To conduct supervised classification using the SCP tool in QGIS, the first step involved loading the Landsat image into the QGIS 

software. Following the image loading process, the SCP tool was accessed by navigating to Plugins, Semi-Automatic Classification, 

Classification, and Create New Classification. Within the "New Classification" window, the option for "Supervised Classification" was 

chosen, and specifically, the Maximum Likelihood algorithm was selected for this particular analysis. Training samples were created 

for each class by digitizing polygons over corresponding areas in the image that represented those specific classes. This was achieved 

by clicking on the "Draw Polygon" button in the SCP toolbar and subsequently clicking on the image to generate the desired polygon 

shape. Once all the training samples were created, the classification process was initiated by selecting the "Run Classification" button. 

The SCP tool employed the Maximum Likelihood algorithm to classify individual pixels in the image based on their spectral 

characteristics. 
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Topographic characteristics 

To process elevation, slope, aspect, and landforms using DEM (Digital Elevation Model) data in QGIS, the following steps can be 

followed: 

Loading DEM Data: Imported the DEM data into QGIS by adding the corresponding raster layer. This was achieved by navigating to 

Layer > Add Layer > Add Raster Layer. 

Elevation Analysis: (a). Visualizing Elevation: Applied a color ramp to the DEM layer to visualize the elevation. This was done by right-

clicking on the layer in the Layer Panel, selecting Properties, navigating to the Symbology tab, and choosing a suitable color ramp. (b). 

Extracting Elevation Values: Utilized the Raster Calculator tool to extract elevation values. Accessed Raster > Raster Calculator, selected 

the DEM layer as the input, and defined the desired calculation or analysis. 

Slope Analysis: (a). Calculating Slope: Used the Slope tool in QGIS to calculate the slope. Went to Raster > Analysis > Slope, specified the 

input DEM layer, selected the appropriate slope calculation method (e.g., Horn, Zevenbergen, and Thorne), and configured the output 

parameters. (b). Visualizing Slope: Applied a color ramp to the slope layer in the Layer Properties, similar to the elevation analysis. 

Aspect Analysis: (a). Determining Aspect: Employed the Aspect tool in QGIS to calculate the aspect. Navigate to Raster > Analysis > 

Aspect, choose the DEM layer as the input, and set the output parameters. (b). Visualizing Aspect: Applied a suitable color ramp to the 

aspect layer in the Layer Properties. 

Landform Analysis: (a). Deriving Landforms: To identify landforms such as valleys, ridges, and drainage networks based on elevation 

and slope characteristics, utilized tools like Terrain Analysis - Hydrology (TauDEM plugin) or GRASS GIS tools (available through the 

Processing Toolbox). 

 

Data Analysis 

Objective 1; to identify and analyze the land use and land cover changes observed in Gamawa Local Government Area (LGA) from 

1999 to 2022. A land use/land cover (LULC) classification scheme was established in QGIS to analyze its extent within Gamawa Local 

Government Area (LGA). This scheme utilized a classified raster image, where each pixel value represents a specific LULC class. The 

analysis workflow involved: 

1. Loading the Classified Image: The classified image was loaded into QGIS. 

2. Creating Polygon Vector Layer: Pixel size was determined, and the "Raster to Polygon" tool converted the image into a polygon vector 

layer. Each polygon represents a distinct LULC class. 

3. Calculating Area: The field Calculator in QGIS was used to calculate the area (in square kilometers) of each polygon, determining the 

aerial extent of each LULC class. 

4. Calculating Percentage Cover: To compare coverage, the areas were converted to percentages. This involved:  

Calculating the total study area by summing all LULC class areas. 

Using the Field Calculator to create a new attribute field and calculate the percentage for each class by dividing its area by the total and 

multiplying by 100. 

 

Analyzing Change in LULC Over Time 

LULC values for each year were obtained from separate satellite imagery analyses. The magnitude of change (C) between two years is 

calculated by subtracting the LULC value of the earlier year (A) from the later year (B): 

C = B - A 

Where: 

C = Magnitude of Change 

B = LULC Value (Later Year) 

A = LULC Value (Earlier Year) 

The percentage of change (E) is calculated using the formula: 

E = (C / Base Year) * 100 

Where: 

E = Percentage of Change 

C = Magnitude of Change 



 

ARTICLE | OPEN ACCESS    

 

 

 

Discovery Nature 1, e3dn1019 (2024)                                                                                                                                                               5 of 17 

Base Year = Reference Value for Comparison 

 

Objective 2; to examine the topographic characteristics of the study area 

Begin by loading the topography layers into the QGIS environment. Once loaded, explore the style panel associated with the raster 

layer you wish to analyze. This panel allows you to customize how the data is visually represented. You can apply color ramps or 

thresholds to highlight different elevation values within the data. To gain deeper insights, generate a unique values report. This report 

provides valuable information about the distinct elevation values present in the layer, along with their corresponding frequencies (how 

often each value appears) and potentially their area coverage. Analyze the unique values report to identify the frequency or count 

associated with each unique elevation value. Multiply this count by the area covered by each pixel (usually specified in the layer 

metadata) to calculate the total area for each elevation class. Finally, to express these areas as percentages, divide the area of each value 

by the total area of the layer and multiply by 100. 

 

Objective 3; to compare the findings of this research with existing research results 

To review existing research and conduct a comparative analysis of studies assessing desertification using Remote Sensing and GIS 

techniques, follow these steps: 

Literature Search: Conduct a comprehensive literature search using academic databases, research repositories, and relevant journals. 

Use keywords such as "desertification assessment", "Remote Sensing", "GIS", and related terms to identify relevant studies. 

Selection Criteria: Establish criteria for selecting studies to include in your comparative analysis. Consider factors such as study design, 

methodology, data sources, geographic location, and the quality of research. Exclude studies that do not meet your predetermined 

criteria. 

Analyze Trends and Patterns: Analyze the data to identify consistent trends or patterns across the studies. Assess the agreement or 

disagreement in the findings related to desertification assessment. Consider the strengths and weaknesses of the Remote Sensing and 

GIS techniques employed in the studies 

Draw Conclusions: Summarize the findings of the comparative analysis, highlighting the similarities, differences, and inconsistencies 

across the studies. Assess the overall reliability and accuracy of Remote Sensing and GIS techniques for desertification assessment 

based on the collective evidence. 

 

3. RESULTS AND DISCUSSION 

Identify and analyze the land use and land cover changes 

The land use land cover of Gamawa LGA, 1999, 2010, and 2022 was characterized into five prominent classes which include: Built-up, 

Cropland, Grassland, Vegetation, and Water bodies as shown below 

 

Table 2 shows the distribution and pattern of Land use land cover of Gamawa L.G.A 

LULC 
1999 2010 2022 

Area Percentage Area Percentage Area Percentage 

Built up area 4.69 0.16% 28.09 0.98% 51.60 1.81% 

Cropland 1955.33 68.43% 1910.16 66.85% 1855.53 64.94% 

Grassland 847.22 29.65% 855.94 29.96% 925.89 32.40% 

Vegetation 41.52 1.45% 55.70 1.95% 23.11 0.81% 

Water Bodies 8.63 0.30% 7.49 0.26% 1.26 0.04% 

Total 2857.39 100.00% 2857.39 100.00% 2857.39 100.00% 

 

This study analyzes changes in land use and land cover (LULC) within Gamawa LGA, Bauchi State, over time. Data from Table 2 

reveals significant shifts in LULC categories between 1999, 2010, and 2022 (Figures 2 to 4). Built-up Area: In 1999, built-up areas 

occupied a small portion (0.16%) of the total area (4.69 km²). This area steadily expanded to 28.09 km² (0.98%) by 2010 and further 
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increased to 51.60 km² (1.81%) in 2022. Cropland: The most extensive land use category, cropland covered 1955.33 km² (68.43%) in 1999. 

However, it has experienced a slight decrease, reaching 1910.16 km² (66.85%) in 2010 and 1855.53 km² (64.94%) in 2022.  

Grassland: The second-largest category, grassland, covered 847.22 km² (29.65%) in 1999. It showed a minor increase to 855.94 km² 

(29.96%) in 2010 and a more substantial rise to 925.89 km² (32.40%) in 2022. Vegetation: Representing natural areas, vegetation covered 

41.52 km² (1.45%) in 1999. It initially increased to 55.70 km² (1.95%) in 2010 but then declined to 23.11 km² (0.81%) in 2022, indicating a 

decrease in natural vegetation cover over time. Water Bodies: Water bodies, including rivers, lakes, and ponds, occupied a relatively 

small area: 8.63 km² (0.30%) in 1999. This area has shrunk further, reaching 7.49 km² (0.26%) in 2010 and experiencing a significant 

decline to a mere 1.26 km² (0.04%) in 2022, suggesting a substantial loss of water resources within Gamawa LGA. 

To assess the extent of desertification in Gamawa Local Government Area (LGA) of Bauchi State, we can interpret and explain the 

results provided in Table 3, which shows the changes in land use and land cover (LULC) between different periods. Between 1999 and 

2010, the built-up area increased by 23.40 km² (498.91%), and from 2010 to 2022, it further increased by 23.50 km² (83.66%). Overall, 

from 1999 to 2022, the built-up area expanded by 46.91 km² (999.98%), indicating significant growth in urbanization and infrastructure 

development. From 1999 to 2010, the cropland area decreased by 45.17 km² (-2.31%), and from 2010 to 2022, it further declined by 54.62 

km² (-2.86%). Over the entire period from 1999 to 2022, the cropland area decreased by 99.79 km² (-5.10%), indicating a significant 

reduction in agricultural land. 

Between 1999 and 2010, the grassland area increased by 8.73 km² (1.03%), and from 2010 to 2022, it further expanded by 69.95 km² 

(8.17%). Overall, from 1999 to 2022, the grassland area grew by 78.67 km² (9.29%), suggesting an increase in grassland areas, which 

could be due to natural vegetation growth or livestock pasture. From 1999 to 2010, the vegetation area increased by 14.18 km² (34.16%), 

but from 2010 to 2022, it decreased by 32.60 km² (-58.52%). Overall, from 1999 to 2022, the vegetation area decreased by 18.41 km² (-

44.35%), indicating a decline in the extent of natural vegetation cover. Between 1999 and 2010, the water bodies area decreased by 1.14 

km² (-13.26%), and from 2010 to 2022, it further declined by 6.23 km² (-83.18%). Overall, from 1999 to 2022, the water body area was 

reduced by 7.37 km² (-85.41%), suggesting a significant loss of water bodies within Gamawa LGA. 

 

Table 3 Shows the Land use land cover changes of Gamawa L.G.A 

LULC 1999 - 2010 % 2010 - 2022 % 1999 - 2022 % 

Built up area 23.40 498.91% 23.50 483.66% 46.91 999.98% 

Cropland -45.17 -2.31% -54.62 -2.86% -99.79 -5.10% 

Grassland 8.73 1.03% 69.95 8.17% 78.67 9.29% 

Vegetation 14.18 34.16% -32.60 -58.52% -18.41 -44.35% 

Water Bodies -1.14 -13.26% -6.23 -83.18% -7.37 -85.41% 

 

Examine the topographic characteristics of the study area 

The topographic characteristics examined in Gamawa were Elevation, aspect, slope, and landform as shown below. The table presents 

data on the elevation distribution within Gamawa Local Government Area (LGA) as outlined in (Table 4 & Figure 5). The elevation 

ranges are provided, along with the corresponding area coverage and percentages 
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Figure 2 Spatial distribution and pattern Land use land cover of Gamawa LGA 1999 

Source: Author’s Analysis 2023 
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Figure 3 Spatial distribution and pattern Land use land cover of Gamawa LGA 2010 

Source: Author’s Analysis 2023 
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Figure 4 Spatial distribution and pattern Land use land cover of Gamawa LGA 2022 

Source: Author’s Analysis 2023 
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Table 4 Shows the Elevation of Gamawa LGA  

Elevation Area % 

346 – 358 490.76 17.09% 

258 – 369 1064.93 37.09% 

369 – 381 719.94 25.07% 

381 – 392 464.18 16.17% 

392 -404  131.53 4.58% 

Total 2871.35 100.00% 

 

The elevation range 346 - 358 covers an area of 490.76 km², representing (17.09%) of the total area. The land within this elevation 

range is relatively lower compared to the other ranges. The range 358 - 369 represents the largest portion, with an area of 1064.93 km², 

accounting for (37.09%) of the total area. The land within this range is moderately elevated. The range 369 - 381 covers an area of 719.94 

km², comprising (25.07%) of the total area. The land within this range is moderately elevated, similar to the previous range. The range 

381 - 392 accounts for (16.17%) of the total area, with an area of 464.18 km². The land within this range is moderate to high in elevation. 

The range 392 - 404 covers a smaller area of 131.53 km², representing 4.58% of the total area. The land within this range is relatively 

higher in elevation. 

Table 5 & Figure 6 presents data on the aspect distribution within Gamawa Local Government Area (LGA). The aspects are 

categorized as North, East, South, and West, with corresponding areas and percentages. 

 

Table 5 Shows the Aspect of Gamawa LGA 

Aspect Area Percentage 

North 729.45 25.85% 

East 699.78 24.80% 

South 699.16 24.78% 

West 692.95 24.56% 

Total 2821.33 100.00% 

 

The North aspect covers an area of 729.45 km², representing (25.85%) of the total area. This indicates a significant portion of the land 

within Gamawa LGA faces towards the North direction. The East aspect encompasses an area of 699.78 km², accounting for (24.80%) of 

the total area. This suggests a substantial portion of the land within the LGA faces towards the East direction. The South aspect covers 

an area of 699.16 km², comprising (24.78%) of the total area. This indicates that a considerable portion of the land within Gamawa LGA 

faces towards the South direction. The West aspect represents an area of 692.95 km², representing (24.56%) of the total area. This 

suggests a significant portion of the land within the LGA faces towards the West direction. 
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Figure 5 Spatial distribution of Elevation of Gamawa LGA 

Source: Author’s Analysis 2023 

 

 



 

ARTICLE | OPEN ACCESS    

 

 

 

Discovery Nature 1, e3dn1019 (2024)                                                                                                                                                               12 of 17 

 
Figure 6 Spatial distribution Aspect of Gamawa LGA 

Source: Author’s Analysis 2023 

 

Table 6 & Figure 7 presents data on the landform distribution within Gamawa Local Government Area (LGA). The landforms are 

categorized as Streams, Drainage, Valley, Plain, Slope, and Ridges, with corresponding areas and percentages. 
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Table 6 Shows the Landform of Gamawa LGA  

Landform Area Percentage 

Stream 235.09 8.19% 

Drainage 190.83 6.65% 

Valley 172.78 6.02% 

Plain 1646.93 57.36% 

Slope 199.49 6.95% 

Ridges 426.26 14.85% 

Total 2871.37 100.00% 

 

The Stream landform covers an area of 235.09 km², representing (8.19%) of the total area. This indicates the presence of flowing 

water bodies, such as rivers or streams, within Gamawa LGA. The Drainage landform encompasses an area of 190.83 km², accounting 

for (6.65%) of the total area. This suggests areas with natural drainage channels that facilitate the movement of water across the 

landscape. The Valley landform covers an area of 172.78 km², comprising (6.02%) of the total area. This indicates the presence of low-

lying areas between hills or mountains, typically characterized by the presence of a river or stream. 

The Plain landform represents the largest portion, with an area of 1646.93 km², accounting for (57.36%) of the total area. This 

suggests vast areas of relatively flat or gently sloping land within Gamawa LGA. The Slope landform encompasses an area of 199.49 

km², representing (6.95%) of the total area. This suggests areas with inclined surfaces or gradual elevation changes. The Ridges 

landform covers an area of 426.26 km², comprising (14.85%) of the total area. This indicates the presence of elevated landforms, 

typically characterized by narrow, elongated ridges.  

Table 7 & Figure 8 presents data on the slope distribution within the study area, specifically Gamawa Local Government Area 

(LGA). The slope ranges are given, along with the corresponding area coverage and percentages. 

 

Table 7 Shows the Slope of Gamawa LGA 

Slope Area Percentage 

0 - 3.88 2758.52 96.38% 

3.88 - 7.79 102.56 3.58% 

7.79 - 11.68 0.98 0.03% 

11.68 - 15.57 0.04 0.0013% 

15.57 - 19.46 0.002 0.00% 

Total 2862.10 100.00% 

 

The slope range of 0 - 3.88 covers the largest area, with a total of 2758.52 km², representing (96.38%) of the total area. This indicates 

that the majority of the land in Gamawa LGA has relatively gentle slopes, which suggests a predominantly flat or mildly sloping 

terrain. The slope range of 3.88 - 7.79 encompasses an area of 102.56 km², accounting for (3.58%) of the total area. This range represents 

areas with slightly steeper slopes compared to the previous range but still relatively gentle. 

The slope range of 7.79 - 11.68 covers a very small area of 0.98 km², representing only (0.03%) of the total area. This range indicates 

areas with moderately steeper slopes. The slope range of 11.68 - 15.57 occupies an even smaller area of 0.04 km², accounting for 

(0.0013%) of the total area. This suggests areas with relatively steep slopes. The slope range of 15.57 - 19.46 covers an extremely small 

area of 0.002 km², representing an almost negligible percentage of the total area. This range indicates areas with very steep slopes, 

which are likely to be rare within Gamawa LGA. 
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Figure 7 Landforms of Gamawa LGA 

Source: Author’s Analysis 2023 
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Figure 8 Spatial distribution Slope of Gamawa LGA 

Source: Author’s Analysis 2023 

 

Comparing Findings with Existing Research 

This research on land use and land cover (LULC) changes in Gamawa LGA (1999-2022) aligns with existing studies on desertification. 

The research shows a significant increase in built-up areas (999.98%), reflecting rapid urbanization. This aligns with other studies 
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Ibrahim et al., (2022), Aliero and Ismail, (2016) that highlight human activities as major contributors to desertification. Decreasing 

Cropland: The decrease in cropland area (5.10%) suggests a decline in agricultural land. This aligns with studies by Ibrahim et al., 

(2022) and Jibril et al., (2022) who report land cover conversions. Grassland Expansion: The increase in grassland area (9.29%) could be 

due to natural vegetation growth or conversion from other land uses. While grasslands can offer some benefits, studies by Elijah et al., 

(2017) suggest they might indicate the conversion of more resistant land covers like forests, ultimately impacting desertification.  

Shrinking Vegetation: The concerning decrease in vegetation cover (44.35%) is a significant desertification risk factor. Similar trends 

are reported by Ibrahim et al., (2022) and Elijah et al., (2017), highlighting the negative impacts of land use changes. Water Loss: The 

substantial loss of water bodies (85.41%) indicates water scarcity and reduced groundwater levels, contributing factors in 

desertification research by (Aliero and Ismail, 2016). Generally, findings on LULC changes in Gamawa LGA support existing research 

on the negative impacts of human activities on desertification. The expansion of built-up areas, decline in cropland and vegetation, and 

loss of water bodies all contribute to increased vulnerability to desertification. This emphasizes the need for sustainable land 

management practices to mitigate these effects. 

 

4. CONCLUSION 

This study reveals significant land degradation and ongoing desertification processes in Gamawa LGA. These processes have negative 

consequences for the environment, agriculture, livelihoods, and human well-being. The study also highlights the value of remote 

sensing and GIS techniques in assessing and monitoring desertification. These tools provide accurate and comprehensive spatial data, 

crucial for understanding desertification processes. Based on these findings, further research is recommended on desertification across 

other regions of Bauchi State and Nigeria. Additionally, exploring interventions to combat desertification and promote sustainable 

development is crucial for mitigating these environmental challenges. 

 

Recommendations 

The study's findings and conclusions suggest several recommendations for addressing desertification in Gamawa LGA: 

Afforestation programs: Implement afforestation programs by planting native tree species suited to the local climate and soil conditions. 

Incentives and support should be provided to engage local communities in tree planting and maintenance activities. 

Soil conservation measures: Adopt soil conservation practices such as organic fertilizers, crop rotation, mulching, contour plowing, 

terracing, and agroforestry. These measures can enhance soil fertility, reduce erosion, retain water, and prevent salinization. 

Water management strategies: Develop and implement water management strategies, including constructing dams, reservoirs, wells, and 

irrigation systems. Promote water harvesting techniques like rainwater collection and storage to increase water availability for various 

purposes. 

Education campaigns: Conduct education campaigns targeting different stakeholders to raise awareness of desertification, its causes, and 

its consequences. Provide information on signs of desertification, its impacts on the environment and society, and best practices to 

prevent and combat it. 

Policy reforms: Undertake policy reforms to govern and coordinate desertification prevention and control efforts. Revise and implement 

existing policies and regulations related to land use planning, environmental protection, natural resource management, and climate 

change adaptation. Establish and strengthen institutions for monitoring, evaluation, reporting, and enforcement of desertification-

related policies and actions. 

Community participation: Encourage and facilitate community participation in planning, implementing, monitoring, and evaluating 

desertification-related projects. Respect local knowledge, values, needs, preferences, and rights concerning land use and management 

to ensure sustainability and success of interventions. 
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